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D

InDesign, Photoshop, Illustrator and Acrobat Pro now work harder together to help you be more creative and work faster

esigners today have to work harder 
than ever to get the job done. 
Competition has never been fiercer, 

and in these cash-strapped times workflow 
efficiency is key. It’s such efficiency that 
Adobe offers with its new Creative Suite 5.5 
Design Standard, a family of graphic design 
tools that work together to solve many of 
the problems designers face.

Creative Suite 5.5 Design Standard 
combines the latest versions of the tools 
every designer needs: InDesign, Illustrator, 
Photoshop, Acrobat Pro and Bridge. 
Designers upgrading from Creative 
Suite 4 will find a wealth of new design, 
illustration, photo manipulation and 
production tools – and if you haven’t 
upgraded since Creative Suite 3, you will 
be blown away by just how quickly you can 
put together breathtaking print projects.

The brand new Creative Suite 5.5 release 
adds digital publishing tools for designers 

with their eye on producing projects for 
devices such as the iPad, but also introduces 
a subscription scheme that enables you to 
own Creative Suite 5.5 for as little as £52 
plus VAT per month. 

A key theme of this latest collection is 
integration between applications, which is 
something of a tradition for the Creative 
Suite. The use of an integrated platform for 
design, illustration and print work addresses 
the common concerns of font and graphic 
consistency across a project as well as colour 
management, especially when multiple 
designers are involved. Of course, the best 
way to find out how effective the Design 
Standard edition of the Adobe Creative 
Suite is to ask people who depend on it. 

“There seems to be more synergy 
between the applications in [the latest 
version of] Creative Suite, with greater 
support for the bespoke features of each 
application,” says designer Oliver Lindsey 

BE A BETTER DESIGNER 

of Play Nicely. “For example, layer comps 
from Photoshop being seen as ‘pages’ 
in InDesign. You can work within the 
programs best suited to each job and then 
update multiple documents in one go, 
rather than having to work from separate 
files and keep track of updates, changes and 
templates across multiple files and versions.”

As print jobs become more complex 
they place greater demands on the software 
and computers of designers. It’s not 
uncommon these days for design projects 
to be based on high resolution assets such 
as Raw files from digital cameras, produce 
comps of 2GB in size or to work with High 

Left Digital marketing 
agency Tullo Marshall 
Warren used Adobe 
Creative Suite to create 
the You + Nissan 
CARE campaign

IN-DEPTH ADOBE CREATIVE SUITE 5.5 DESIGN STANDARD

There is more synergy between the 

applications in Creative Suite, with greater 

support for the bespoke features
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down images into components for large 
campaigns, we can now work to a much 
higher specification in a single piece and 
achieve the same or better end results.” 

Collaboration is central to many design 
projects, but can be aided by the asset 
sharing facilities of the Share My Screen 
command introduced into Creative Suite 4 
Design Standard. It allows colleagues to see 
your desktop on their screens as you work 
using the format of a live web conference. 
You can start working online with 
immediate feedback, with up to two guests 
at a time for no additional service charge, 
although a studio level service will require 
a subscription. 

Adobe Creative Suite Design Standard 
5.5 products also integrate with Adobe  
CS Review, part of the new Adobe CS 
Live set of online services. This can really 

streamline collaborative working by 
initiating shared reviews from 

within Photoshop, Illustrator, 
and InDesign. You can 
invite colleagues and clients 

to comment with easy-to-use 
annotation tools, and then view 

comments within the context of your layout 
– so the changes needed are clearly marked, 
and making them is swifter and simpler. 

Another form of collaboration leads  
to inspiration: Kuler, accessed via a Panel  
in many of the suite applications, gives  
you access to thousands of colour themes 
shared online by Adobe and other designers. 
It lets you browse themes by criteria like 
most popular or highest rated, or search 
themes by tag word, title, or creator. Chosen 
themes can then be downloaded and moved 
to your Swatches panel with a single click.

Of course all these designers working 
on projects gives rise to a very large number 
of files, and organising these assets can be 
a big problem. Since Adobe Creative Suite 
2, such asset management duties have 
been provided by Adobe Bridge. The latest 
enhancements to this central component 
offer faster performance and a variety of 
views with rich data, one-click full-screen 
previews and search results. You can 
organise related assets in collections, based 
on either freeform or search-based virtual 
groups, even when assets are spread across 
multiple folders. 

Dynamic Range images of 32-bit colour 
space. To support this demanding workflow, 
the most recent versions of Photoshop and 
Acrobat are now 64-bit applications. This 
means they have access to a greater amount 
of memory and can process more data, thus 
delivering better performance.

Some of the latest components of 
Creative Suite 5.5 Design Standard can 
also take advantage of the power of your 
graphics card for GPU-accelerated features. 
For example Photoshop uses OpenGL to 
dynamically resize brushes, adjust bristle 
hardness, and display a colour sampler ring 
when working with the Eyedropper and 
onscreen colour picker.

“The 64-bit release [of Photoshop CS5] 
is a major improvement for our workflow,” 
says Lindsey. “It allows large-scale artwork 
to be worked on in much higher resolution, 
and without such a broken workflow. 
Where previously we would have to break 

The 64-bit Photoshop CS5 is a major 
improvement for our workflow. We can work 
to a much higher specification and achieve 
better end results

Right Branding work 
by Lyall Bruce of 
Sooper Double D, 
created using InDesign 
and Illustrator CS5

Above and right 
Spreads from HUCK 
magazine, published  
by creative agency The 
Church of London who 
use “every publishing 
package Adobe has,” 
says creative director 
Rob Longworth
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• �Collaborate with colleagues via Share 
My Screen, part of the CS Live suite 
of productivity tools  

• �Use Kuler to explore and create colour 
themes, or extract and share your own 

• �Streamline application interfaces 
with tabbed document layouts, self-
adjusting and spring-loaded panels, 
and task-specific workspaces  

• �Benefit from improved watermarking, 
web galleries, enhanced previews and 
batch processing in Adobe Bridge 

• �Access and manage assets directly in 
Photoshop and InDesign using the 
Mini Bridge panel

There’s also new support for previewing 
PDF contact sheets and the Review mode, 
which cycles selected images in a carousel. 
In addition a new panelised version of 
Bridge, called Mini Bridge, is available in 
Photoshop and InDesign CS5.5, providing 
quick image access and management from 
within the host applications. This can help 
address the time-consuming task of creating 
complex compositions, which require 
designers to work with multiple images 
individually, and then combine them.

In Creative Suite 5.5 Design Standard 
you can drag and drop images directly 
from Bridge, the Mini Bridge or document 
windows on your desktop into Photoshop. 
Multiple images will become new editable 
Smart Objects in individual layers. The 
saving in time that this feature provides is 
considerable. Whether singly or in a studio 
environment, designers usually go through 
several iterations of a design, and keeping 
track of such versions can be crucial. 

PROJECT TRACKING 
It’s also wise, when a project is being worked 
on by several creatives at once, to be able 
to track who is working on the most recent 
version. The Version Cue control system 
in Creative Suite 4 and older has been 
superseded by Adobe Drive, which retains 
compatibility for Version Cue CS4, but 
also allows the use of a third-party digital 
asset management (DAM). Drive offers 
simple, intuitive access to remote assets 
through Mac and Windows file browsers 
or dialogs such as Open and Save, through 
Adobe Bridge, and directly from the menus 
and UIs of Drive-integrated Creative Suite 
5.5 applications including Photoshop, 

Illustrator and InDesign. Such integration 
allows users to perform asset management 
functions directly from the application, 
such as viewing version history, or adding 
a check-in comment when saving a file. 

Designers often need to have several 
documents open at the same time, but 
comparing and switching between them 
takes time. For increased workflow 
efficiency, Creative Suite 4 introduced a 
new ‘unified’ application frame that 
included a tab-based window, which allows 
you to switch from one open image or 
document to another far more quickly. 

An increase in productivity is also 
delivered by the Application Bar, which 
gives quick access to different interface 
configurations. This was enhanced in CS5 
with task-specific workspaces, which consist 
of the most efficient arrangement of panels 
for workflows such as design, photography 
and painting. The interface also offers 
self-adjusting panels, which dynamically 
resize when you scale the application frame, 
while greater screen real estate is offered by 
spring-loaded panels that can be reduced to 
an icon with a keystroke. 

Together the new enhancements 
reduce the time previously taken to work 
with documents and manage windows 
by half. Such productivity gains might 
seem minimal in some cases – saving a 
few minutes or even a few seconds here 
and there, but when 
those seconds add up 
over days, weeks and 
sometimes months 
spent on a project, 
the efficiency savings 
are considerable.

5 WAYS CREATIVE SUITE 5.5 
DESIGN STANDARD CAN MAKE 
YOU A BETTER DESIGNER  

Left T-shirts produced 
in Illustrator CS5 by 
Season Lab, whose lead 
designer Brian Doran 
says, “I save time and 
money by avoiding 
using a separate 
program from the one 
the artwork was 
designed in to see the 
colour separations”

Far left Brochures and 
posters for the Globe 
Theatre’s Shakespeare 
productions created by 
Play Nicely with 
Creative Suite 5

To learn more, 
visit adobe.com/uk/

designstandard
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IN-DEPTH ADOBE INDESIGN CS5.5

 DESIGNED FOR LIFE 
he latest version of Adobe InDesign 
is built to address the key workflow 
concerns of print designers. With 

each successive version this goal is refined 
and the application is tuned to make tasks 
easier and designers’ time more productive. 

Ever since InDesign CS4, productivity 
has increased with innovations in the way 
print designers produce documents. The 
Rotate Spread View allows you to view your 
document in 90-degree increments – ideal 
for working on a publication with vertical 
elements. When aligning and resizing 
objects, you can use Smart Guides, which 
are dynamically drawn when you transform 
an object, then disappear automatically 
when you stop. You can set preferences for 
the guides, including Smart Spacing, Smart 
Dimensions, and ultra-precise positioning. 

InDesign takes the Smart idea further 
with a context-sensitive Selection Tool 
that enables designers to resize and rotate 
text and image boxes, as well as crop and 
rotate placed images without changing 
tools. Double-clicking on an image with 
the Selection Tool toggles the selection 
between the object frame and its content. 
The Selection Tool turns into the Content 
Grabber, which appears when you mouse 
over an image. With the image selected, 
drag, rotate and transform it without 
affecting the frame itself. Cropping becomes 
simple as the image is moved, but not the 
frame. InDesign also lets you import several 
files in one step using a smarter File > Place 

T

command. It offers thumbnail views of the 
files to more easily find the ones you want. 

Conditional Text is another Smart 
feature introduced in InDesign CS4, 
allowing you to hide or reveal content at 
the paragraph, word, and character levels 
without relying on layers. Apply conditions 
to selected text, then use this feature to 
quickly hide or show all text throughout 
your document with the condition applied. 

The Smart Text Reflow feature works 
in conjunction with Conditional Text to 
automatically reflow the visible text and 
anchored objects. It can also facilitate the 
automatic addition of pages at the end of 
a story, selection or document when text is 
overset. Complex layouts will also benefit 
from the split Columns and Span Columns 
paragraph attributes, which allow you to 
handle content flow more easily. 

There are also productivity 
enhancements, such as those made to the 
Links and Layers Panels. The Layers Panel 
in InDesign CS5.5 features a disclosure 
triangle that can be expanded to reveal 
the objects and their stacking order. The 

Links Panel has been rejigged to display 
placed files, link attributes and metadata 
in a collapsible tree view. Each object is 
displayed in a thumbnail view, which can 
be clicked to access additional information 
about that link, such as scale, rotation, and 
resolution. Multiple instances of the same 
file are grouped in an expandable list and 
can all be updated simultaneously when the 
parent file is edited. 

Adobe Bridge has evolved to become 
a key part of a designer’s toolset. InDesign 
CS5.5 takes this further, with a panelised 
version called Mini Bridge, which provides 
image access and management from within 
the host applications. This offers a quick 
way to drag and drop images onto the 
layout, adding links in the same way as 
the File > Place command. To locate files 
previously used in InDesign, check in Mini 
Bridge for spreads displaying a small link 
icon. Right click such a spread and choose 
Show Linked Files. Mini Bridge displays 
thumbnails of all the assets linked to the 
spread in the Content Pane, even if the 
assets are located in different folders. 

You can also use this tool while within 
InDesign to locate relevant assets without 
leaving the application. Click the status pop 
up menu at the bottom left of the screen 
and choose Reveal in Mini Bridge. The 
Mini Bridge Panel will open and display the 
contents of the folder 
containing the spread 
you’re working on. 

It’s also now easier 
to perform common 
layout design tasks 
far more quickly. 

Right The Gap Tool, 
shown bottom centre, 
is a one-step way to 
adjust the spacing 
between frames by 
directly grabbing, 
moving and resizing the 
whitespace

Below Quickly create a 
contact sheet by placing 
multiple images in a 
grid arrangement

InDesign CS5.5 is packed with increased innovations built to make a designer’s life easier and more productive

5 KEY NEW TOOLS IN  
ADOBE INDESIGN CS5.5

•  �Auto-Fit: a persistent frame-fitting feature maintains 
relationships between content and frames

•  �Mini Bridge: an asset management and workflow tool

•  �Content Grabber: a simplified onscreen manipulator 
that rotates and repositions content

•  �Layers Panel: organise, stack, hide or reveal  
page elements 

•  �Enhanced Page Tool: define different page sizes 

To learn more, 
visit adobe.com/uk/

designstandard
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Far left A brochure 
created in Adobe 
Illustrator, InDesign 
and Photoshop by 
Studio Small. Says 
creative director  
David Hitner: “The 
main advances in 
Creative Suite are the 
convergence of tools 
across applications and 
the ability to transfer 
designs across  
different programs” 

• �Use visual feedback such as 
frame edge, and path and point 
highlighting, or live screen 
drawing for object manipulation

• �Scale or rotate multiple items in 
unison and proportionally resize 
the space between them

• �Adjust layouts with on-frame 
controls or the Gap Tool

• �Use keyboard modifiers to easily 
create grid-based designs

• Maintain proportions with Smart 
Guides and Auto-Fit options

5 WAYS INDESIGN CS5.5 
WILL MAKE YOU A  
BETTER DESIGNER  

The latest version of InDesign is refined 
and tuned to make tasks easier and 
designers’ time more productive

Like the multiple artboards in Adobe 
Illustrator, InDesign now offers support for 
different page sizes in a single document, 
so you could quickly assemble a letterhead, 
business card and brochure cover in the 
same layout. Simply use the Page Tool to 
change settings for existing pages using a 
drop down Control Panel. 

InDesign CS5.5 also features on-object 
controls that make it simple to dynamically 
change the look and feel of a frame as you 
design the layout, for example dragging a 
corner of a frame to directly affect its radius 
and shape. Additionally, a new Auto-fit 
check box allows you to proportionally scale 
content as its frame is resized. 

If you press the arrow keys while 
dragging out the frame tools in InDesign 

CS5.5, such as the Rectangle Tool or Type 
Tool, you can automatically split the frame 
into a grid of smaller frames. InDesign’s 
Alt-drag object duplication method is also 
enhanced by grid mode. You just release 
the Alt key and instead use the arrow keys 
to create multiple and equally-spaced 
duplicates in columns and/or rows. Added 
in InDesign CS5, the Gap Tool provides 
a quick way to adjust the size of a gap 
between two or more items. 

InDesign has offered tools for 
preflighting layouts since the beginning. 
This is the check that the application runs 
before outputting your layout to a print 
job – are fonts and images all legal and in 
place, are there any broken links and so 
on. As such it used to be the last job you 
performed before handing off the project to 
a bureau for a print run or sending the job 
to a local printer in your studio. 

When you package a file in InDesign, 
you create a folder that contains the 
InDesign document, any necessary fonts, 
linked graphics, text files, and a customised 
report. However, InDesign now does away 
with some of the time-wasting aspects 
of this final stage by offering continuous 
preflighting. This alerts you to potential 
production problems as you design and 
fix them in real time. A special Preflight 
Panel and contextual tips let you identify 
the problem objects and offer solutions to 
address them, making this final stage much 
less stressful and letting you get on with the 
job of creative design. 

Far left Customise the 
Links Panel to find, 
sort, and organise 
placed content and view 
link attributes 
Left Click on the 
yellow diamonds on any 
frame corner and drag 
to adjust the size of the 
rounded corners

Left InDesign CS5.5 
offers full editing 
capability at 90-  
and 180-degree angles 
so that you can work 
on non-horizontal 
design elements

Below left The Tool 
Hints panel lists all  
the hidden modifier key 
behaviours available  
for the currently 
selected tool
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IN-DEPTH ADOBE ILLUSTRATOR CS5

  VECTOR MAGIC 

Right Perspective Grid 
allows you to represent 
a scene as the human 
eye naturally perceives it

Below Merge objects, 
break up overlapping 
shapes and subtract 
areas with the Shape 
Builder Tool

Graphic designers will find improved tools in Illustrator CS5 to make digital art a cinch

• �Create one design and adapt it 
for many different deliverables 
using multiple artboards

• �Select, position, and stack 
objects precisely using smart 
guides and isolation modes

• �Move, scale, duplicate, and 
transform objects dynamically 
in true perspective mode

• �Finely control stroke width, 
dashes, arrowheads, and how 
brushes stretch along a path

• �Create complex shapes with 
timesaving tools

5 WAYS ILLUSTRATOR CS5 
WILL MAKE YOU A  
BETTER DESIGNER  

dobe revolutionised its approach to 
graphic design when it introduced 
multiple artboards into Illustrator 

CS4. It’s a feature that allows designers 
to create a design once, then adapt it for 
multiple deliverables. For example you 
could create a design and work with it 
on independent artboards for a poster, a 
postcard, business card and a T-shirt design. 

The feature is enhanced in Illustrator 
CS5, allowing you to work on up to 100 
artboards in one document. It also offers a 
full Artboards Panel, where you can add, 
delete, and duplicate artboards. When 
arranging your new artboards you can take 
advantage of the enhanced version of Smart 
Guides with on-object controls. These show 
readouts of positions and size dimensions 
on your cursor, halving the time previously 

A

taken to align objects. This approach can 
also be seen with the enhanced clipping 
mask that only displays the clipped object 
or group. You can edit the masking object in 
Isolation Mode or choose to make it visible 
using the Clipping Path menu options. 
Illustrator CS5 goes further and allows 
you to draw behind other objects without 
choosing layers or setting the stacking order. 

Illustrator CS5 also introduces enhanced 
stroke capabilities. Chief among these is 
the ability to use the Width Tool to draw 
strokes with variable widths. You can gain 
access to the stroke width and adjust it, or 
move, duplicate and delete the width point. 
Also create and save custom width profiles, 
which you can reapply to any stroke. 
Meanwhile new improvements in corner 
handling mean that stroke shapes behave 
predictably in tight angles or around sharp 
points. You can also access arrowheads from 
the Stroke Panel and associate controls to 
adjust size. 

Transparency is enabled for gradients, 
allowing you to create cover-up fades or 
to reveal underlying objects or images. 
There’s no need to work with the gradient 
panel either, because from Illustrator CS4 
a gradient annotator appears that features 
on-object controls to give instant visual 
feedback. In addition, radial gradients 
are enhanced with the new ability to set 
dimensions independently, to create an 

elliptical gradient of any proportion. Grids 
provide the basics of much print design, but 
Illustrator CS5 allows you to use a grid that 
supports drawing directly in accurate 1-, 2-, 
and 3-point linear perspectives. Using the 
Perspective Grid Tool, it’s also possible to 
create objects in flat space and then apply 
them to a perspective plane, automatically 
transforming them into the correct shape. 

Illustrator CS4 introduced a completely 
new tool, the Blob Brush, which lets 
you sketch a shape freehand style using 
overlapping strokes. When you finish 
painting, these strokes are instantly merged 
to create one clean, unified vector object. 
There’s also the Shape Builder Tool, which 
enables merging of objects, breaking 
overlapping shapes into distinct objects, 
subtracting areas, and more.

Above You can now 
add width points to a 
stroke. Drag either side 
of a stroke in or out 
independently, move 
width points along a 
stroke, and save  
width profiles

Above You can create multiple artboards in different 
sizes, resize them by using the Artboard Tool, and 
position them anywhere on the screen

5 KEY NEW TOOLS IN  
ADOBE ILLUSTRATOR CS5

•  �Perspective Grid: Draw directly on planes of  
true perspective

•  �Enhanced Multiple Artboards: Name, reorder, and 
quickly arrange multiple artboards

•  �Shape Builder: Combine, subtract, and colour 
overlapping shapes without using the Pathfinder Panel

•  �Variable-width strokes: Control width points on a 
stroke and save width profiles

•  �Enhanced Stroke Panel: New controls for arrowheads 
and dashed strokes 

To learn more, 
visit adobe.com/uk/

designstandard
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• �Trial a look by adding non-
destructive adjustments to images 

• �Produce highly accurate, 
re-editable masks 

• �Use Content-Aware tools to fill, 
heal, or resize images

• �Work creatively with images 
using digital darkroom tools 

• �Edit photos at any angle with 
canvas rotation and use GPU-
accelerated pan, zoom, preview, 
and painting tools 

5 WAYS PHOTOSHOP CS5  
WILL MAKE YOU A  
BETTER DESIGNER  

These tools aren’t just gimmicks; rather 
they give valuable and time-saving control 
over the manipulation of images

Above Use Content-
Aware Fill with the 
Photoshop Spot 
Healing brush to 
remove distractions 

Left The HUD Color 
Picker, available as a 
Hue Strip or Hue 
Wheel, is a more 
interactive way to select 
colours and alter their 
saturation

Left The Adjustments 
panel features a wide 
variety of modifiable 
presets for each effect

IN-DEPTH ADOBE PHOTOSHOP CS5

MASTER YOUR ART
esigners work with images every day 
and the power of Adobe Photoshop 
is well known. But just what the 

latest version of the software is capable 
of may surprise even long-term users. 

Photoshop CS4 introduced a dedicated 
Adjustments Panel, which allows one click 
application of Photoshop’s adjustment layers 
effect, complete with a new layer and mask. 
The panel includes the Vibrance adjustment, 
which gives designers greater control over 
colour saturation while preserving delicate 
textures such as skin tones. The Adjustments 
Panel features a wide variety of modifiable 
presets for each effect, including more than 
20 preconfigured, customisable starting 
points. Another productivity boost in this 
area is new on-image adjustments for Hue/
Saturation and Curves.  

Photoshop CS4 also brought image 
refinement a step closer to the true digital 
darkroom with enhancements made to the 
Dodge, Burn, and Sponge Tools. Dodge and 
Burn can be set to protect skin tones while 
Sponge, which changes colour saturation, 
gained a Vibrance setting. Designers 
requiring a more artistic touch are well 
served in Photoshop CS5 with the Mixer 
Brush. This features a ‘wet canvas’ method 
for picking up multiple colours on a single 
tip, then mixing and blending them with the 
underlying hues on the canvas.  

Photoshop CS5’s enhanced workflow 

D
Photoshop CS5 includes new and improved features to make photo retouching and manipulation even quicker and easier

5 KEY NEW TOOLS IN  
ADOBE PHOTOSHOP CS5

•   �Content-Aware fill for retouching images with content 
that seamlessly integrates into its surroundings

•  �Refine Edges for making more accurate selections and 
more professional composites

• � Mixer Brush for traditional painting effects, simulating 
bristles and mixing colours on the canvas 

• � Straighten Edges with the enhanced Ruler tool

• � �HDR Toning for creating highly photorealistic or surreal 
high dynamic range images 

features include a Straighten option for the 
Ruler Tool, allowing realigning of crooked 
photos. An enhanced Zoom function uses 
OpenGL acceleration for continuous and 
smooth zooming and an on-screen HUD 
Color Picker provides quick colour selection 
and alteration of saturation and lightness.  

Selection, masking and object removal 
are key tasks in Photoshop. A top new 
feature is the Refine Radius Tool, which 
enhances the Refine Edge selection utility, 
so makes creating accurate selections 
of intricate elements – like hair – more 
achievable. The powerful Masks feature, 
useful for isolating selections and applying 
effects to precisely-defined areas of an image, 
is now available as a dedicated panel offering 
controls for adjusting pixel and vector masks. 
Quick sliders give access to mask density and 
feathering adjustments, with control over 
both the sharpness of the mask edge and 
how much of the adjustment effect you’d 
like to reveal, while the new Refine Mask 
feature allows fine-grained control over the 
mask size and edges. 

The new Content-Aware Fill Tool can 
‘magically’ remove elements from an image. 
The fill randomly synthesises similar image 
content leaving the space behind with 
matching lighting, tone, and noise. A similar 
effect can be achieved when using the Spot 
Healing Brush Tool with the Content-
Aware setting activated. Another dramatic 

effect can be seen when the Content-Aware 
Scaling feature is used. This time, Photoshop 
will automatically recompose an image as 
you resize it, preserving vital areas such as 
people or buildings, as the image adapts to 
the new dimensions. 

The wow factor doesn’t end there – the 
Puppet Warp feature allows the precise 
repositioning of any element within a 
Photoshop document by simply clicking and 
dragging pinned sections of the image. Of 
course these tools aren’t just gimmicks; rather 
they give valuable and time-saving control 
over the manipulation of images.

Left HDR Toning 
features an adjustable 
slider and a list of 
presets to create the 
stylised look of a high 
dynamic range image 
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CASE STUDY FANTASTIC DESIGN WORK PRODUCED IN ADOBE CREATIVE SUITE

 MINISTRY OF SOUND & VISION

tudio Output is a small but diverse 
team of creatives based in both the 
hearts of Nottingham and London. 

Understanding what is new, what is now 
and what is next, the team translate this 
into inspired, relevant, creative work across 
every medium for brands and companies. 
Currently working on major projects for the 
likes of MTV, Universal Pictures, Westfield 
and Tate, the studio also has a number 
of long-standing clients such as Sony 
PlayStation, BBC, Thomas Cook and Arts 
Council England.

Studio Output has also worked with 
London nightclub Ministry of Sound since 

It has been interesting to use the Creative 
Suite product over the years and for us to 
see the changing styles we have been able 
to create. With it we stay on top of trends

S 2005, creating the artwork for its flagship 
Saturday Sessions nights. This involves 
creating a quarterly concept that will run 
across the monthly flyers for the club. 

“Over the years we have been asked to 
focus on different aspects of the club and 
the brand,” says account director Gemma 
Ballinger. “From drawing attention to 
the iconic logo to creating something less 
obvious to play on the credibility of the DJs 
and nights. Our work has involved coming 
up with creative concepts, working on 3D 
renders, creating hand drawn illustrations 
and also working with a series of illustrators 
to push the artwork in a different direction.

Ballinger says that Studio Output now 
has an open brief from Ministry of Sound, 
as the club trusts them to create something 
original every quarter that perfectly fits with 
their brand ethos.

“Throughout this time we have used 
the features in the Creative Suite Design 
Standard applications to create the flyer 
artwork,” says Ballinger. “It has been 

interesting to use the product over the 
years and for us to see the changing styles 
we have been able to create, and with it we 
stay on top of trends.” The process always 
begins with the team brainstorming ideas 
independently. As Ballinger explains, “These 
ideas are then presented internally at Studio 
Output. We develop the ideas into mood 
boards which are then presented to the team 
at MoS for their feedback. Once a route has 
been chosen we get on with the design.”

Dedicated Ministry of Sound designer 
Shahnaz Ahmed works in-house at the club 
four days a week, using the latest version of 
Creative Suite Design Standard. She says, 
“Generally the working process involves 
sketching initial ideas, these are then 
scanned in and manipulated in Photoshop.”

Once the finished images are created 
in Photoshop, they are imported into 
InDesign to finish the layout of the flyer. 
The imported images in InDesign are 
kept as PSD files so they can be tweaked 
accordingly and re-linked, which has to be 

Right and far right All 
of Ministry of Sound’s 
themed flyers are 
created using all 
Creative Suite Design 
Standard applications

Design agency Studio Output works in conjunction with Ministry of Sound to produce the club’s promotional flyers
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done a number of times to ensure image 
and copy/layout work together.

All the current work on MoS projects is 
done within Adobe Creative Suite Design 
Standard. It’s not the first edition of the 
suite the team has used, but it certainly 
seems to have addressed certain creative and 
technical challenges for them. 

“There seems to be much better 
integration between the suite in the newer 
versions,” says Ahmed. “The Adjustments 
palette in CS5 made adjusting the levels, 
hues and other colour adjustments easier 
than earlier editions of Photoshop, as you 
no longer needed to change them one at a 
time in a pop-up window. The InDesign 
feature which allows you to have multiple 
page sizes in the document really helps 
when designing in different formats and 
enables experimentation on the page.”

Ballinger adds, “Illustrator CS5’s 
perspective tools and 3D features have 
proved very useful in work we have done for 
previous Ministry of Sound flyers and for 
different clients including HMV and Sony 
PlayStation. Previously we would have been 
more reliant on Cinema 4D for some of the 
functionality we can now find in CS5.”

An example of the process can be seen 
in a poster for a Saturday Sessions featuring 
Basement Jaxx: a collage of two images 
coming together to create the illusion of as 
many animals as the viewer can see. “The 
peacock in the foreground is the main 
focal animal here, and its feathers create 
the eyes for other animals behind it,” says 
Ahmed. “Images of the animals were used 
as guidelines, while images of smoke and 
lightning were collated and placed to give 
the illusion the animals were turning into 
smoke. There were many layers involved 
in making this image, and all needed layer 
adjustments, which were made easier by 
Photoshop CS5’s Adjustment Panel.” The 
panel allows each layer change to be made 
faster than doing them individually in 
dialog boxes. The new symbols representing 
the different layer adjustments make it 
easier and quicker to jump to the different 
adjustments, instead of the usual keyboard 
shortcut or going through the Image menu.

2011 is a special year for MoS as it is the 
club’s 20th anniversary. To celebrate there 
are special events, including club nights and 
exhibitions to mark the occasion. Studio 
Output’s flyer artwork from the last six years 

Top left A flyer to 
promote a Basement 
Jaxx club night
Top right Flyer designs 
are themed each month, 
with a new theme 
emerging each quarter
Left and far left Flyers 
to promote the Ministry 
of Sound’s 20th 
birthday reflect the 
club’s unique floorplan

THE MAGIC TOOL: PHOTOSHOP CS5’S CONTENT-AWARE FILL

� It is often a challenge to make diverse images of DJs work together to create an eye-
catching piece of artwork for Ministry of Sound, such as the flyer artwork (left).  

“The Clone Tool used to be the main tool used to recreate whole areas that were 
missing, but it was time-consuming to do it well,” says designer Shahnaz Ahmed. “The 
new Content-Aware Fill in Photoshop CS5 has cut a significant amount of time. For me  
it’s the new magic tool, the new Clone Tool for areas that don’t even exist. Within 
seconds I can create whole areas of a sunset sky, brick wall, or any background, 
keeping the lightening or darkening of the image consistent.

“By just highlighting which parts I want to fill in, or get rid of, whole areas of wall, or 
sky, or tree are seamlessly made up or deleted within seconds. The time saved is much 
appreciated when the turnaround of work is so fast.”

has been displayed in a gallery space. 
“To celebrate Ministry of Sound’s 20th 

birthday this year,” Ballinger says, “the 
concept for the April to June flyers was to 
focus on the club’s floorplan, which is split 
over four rooms and two floors. Collecting 
imagery, experiences and objects from the 
club itself, the illustration simplifies the 
club down to vector form; geometric lines 
slotting together to create a swarm of shapes 
and colours.” 

Ahmed adds, “In the April to June  
flyers, designs went from sketchbook 
straight to Illustrator CS5. Once work 
was completed in Illustrator, it was then 
imported into InDesign to lay out all 
the copy. It was easy to switch between 
both applications when anything needed 
tweaking. Being able to set your bleed 
on Illustrator was really helpful because 
it imported into InDesign seamlessly. 
Previously we may 
have just created a 
larger Artboard in 
Illustrator. Having 
multiple Artboards 
really helped with the 
working process.”

To learn more, 
visit adobe.com/uk/

designstandard
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CASE STUDY STRIKING DESIGNS USING ADOBE CREATIVE SUITE 

MADE EASY

y day Manchester-born Andy Thirsk 
is designer and art director for The 
Think Tank in London. But he also 

has his own personal design venture, Made. 
Over the past seven years, Thirsk has 

worked with brands such as Toni&Guy, 
Dulux, Bridgestone and RBS, while the 
large variety of different projects he takes on 
as Made has enabled him to turn his hand 
to everything from design, to illustration 
and photography.  

One such client was the Daily Mail, for 
whom Thirsk’s Made studio was asked to 
create and design the front cover of a football 
pullout supplement. He says, “With the 
Premier League about to start, they wanted 
the piece to highlight some of the key 
players at the clubs fighting for the title, 
such as Rooney, Drogba and Torres.”  

Thirsk had the idea of comparing the 
strikers to hitmen, so he sketched out the 
idea and sent it over to the editor. The main 

B

inspiration for the look of the design came, 
Thirsk says, from an image from the film 
Reservoir Dogs, which showed the various 
character photos in strips.  

“I decided this could be a good start as 
I would have to highlight several different 
people within the design,” he explains. “This 
approach could be more interesting, and 
would also give me the option to be more 
accurate with the angles of the players.  

“For the initial roughs I used the Live 
Trace Tool in Illustrator CS5,” he says. The 
Live Trace Tool allows scanned drawings to 
be swiftly turned into editable vectors. “This 
meant I could have more control over the 
shape and features of the players, making 
them more recognisable and enabling me to 
adjust them to best fill the allocated space 
within the layout.”  

Thirsk says that for the final design, 

he used a 
paintbrush effect 
in a single colour as 
a background to each player. He 
says that this enabled him “to add more 
colour to the design, but also gave each 
player more emotion by using an explosion 
of paint in the team colours to give it that 
burst of energy.”   

The project was created using pencil and 
paper for sketching, then all of the key art 
and design applications within the latest 
version of Creative Suite Design Standard: 
Illustrator, Photoshop and InDesign. Thirsk 
explains that the integration of the Creative 
Suite applications was a definite help.  

“With three of the Adobe Creative 
Suite programs being so instrumental in 
the design, it was important that they work 
well together,” he says. “With the job being 
for a newspaper, it meant that even minor 
amends needed to be made accurately and 
quickly due to tight time frames.”   

The illustrations were drawn in 
Illustrator, but the backgrounds behind 
each player were created in Photoshop and 
the layout was put together in InDesign.  

“This meant that if there was a change 
to the illustration, or even the background, 

Above and right 
The Daily Mail 
supplement cover 
in its various stages

Andy Thirsk used a winning mix of Illustrator, Photoshop 
and InDesign to create a sport supplement front cover
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Creative Suite makes a smooth process  
of amendments, automatically updating links 
between applications. Speed and accuracy 
are vital when working to tight time frames

I would need to amend two, maybe 
three files before adjusting the layout in 
InDesign,” Thirsk explains. “The Creative 
Suite automatically amended these links as 
and when they were updated. This saved me 
a lot of time, improving workflow.”  

Thirsk created illustrations for 10 
players, from which five would be chosen 
to be used in the supplement. Thirsk says, 
“There was lots of tweaking and amends 
that had to be done efficiently. Creative 
Suite made this a smooth process; I didn’t 
have to worry about the programs I used 
conflicting with each other.”  

Suite Dreams
Thirsk is a long-term user of the Creative 
Suite. Asked about which tools from the 
newest versions of the Creative Suite Design 
Standard lineup have given him the most 
artistic opportunities, Thirsk says that 
Illustrator’s latest additions have made a 
huge impact.  

“The interactive gradients in Illustrator 
are a fantastic addition,” he says. “It used 
to be such a fiddly job to tweak gradients 
using the options given in the Gradients 

Window. With this feature I can now adjust 
the gradient on the actual design. This gives 
me the scope to be more precise about how 
quickly the gradient changes, the angle, the 
start and end points, and the shape. It’s so 
helpful to be able to see the changes I make 
happen instantaneously in my design.  

“Illustrator’s multiple artboards are also 
such a timesaving benefit, especially when 
at the concept stage of a design. When I 
design in Illustrator, one design can quite 
easily lead to a slightly different one; a 
progression. The multiple pages mean that 
I no longer need several different files for 
the various designs. I can now see all the 
options together, which assists in the design 
decisions. It’s equivalent to printing all of 
them out and sticking them on the wall.”  

Thirsk says Creative Suite 5 Design 
Standard has made his working methods 
a lot faster. “Creatively it has meant that 
programs no longer dictate what can and 
can’t be done when it comes to design,” 
he says. “If I want to do something in 
particular, there are fewer restrictions on 
what can be done. In this respect it boosts 
creativity by removing restrictions.”  

Andy Thirsk made use of the output 
features in InDesign CS5 to create a press-
ready PDF for the Daily Mail.  

“This feature is so much more advanced 
and easier to use than my old system for 
sending a job to print,” he says. “InDesign 
has the benefit of allowing so much control 
over options such as transparencies and drop 
shadows. And the PDF export process is so 
simple. As well as being able to preflight a 
PDF for potential problems before I have 
even made it, there are accurate presets for 
particular styles. So if I want a press-ready 
PDF or a low-res PDF for proofing, I can 
just select the Adobe 
PDF presets for 
them. [It’s] a more 
simple, efficient and 
trustworthy process 
for the production of 
print-ready files.” 

Above and left Andy 
Thirsk produced the 
supplement cover using 
the latest versions of 
Illustrator, Photoshop 
and InDesign

Left and far left  
Andy Thirsk’s work  
also includes the design 
and layout &What, a 
publication featuring 
work and opinions of 
designers, created  
using Creative Suite 
Design Standard

To learn more, 
visit adobe.com/uk/

designstandard
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STEP BY STEP  ADOBE CREATIVE SUITE 5.5 DESIGN STANDARD  

 REBRANDING QUENCHED

n this tutorial, illustrator and graphic 
designer Charles Williams – aka Made 
Up – introduces some of the wonderful 

new things you can do using Creative Suite 
CS5.5, from multiple page sizes in InDesign 
to Content-Aware Fill in Photoshop. Of 
course, lots of sketching and thinking and 
planning is vastly important, so make sure 
you do that too.  

Here Charles details how he put these 
tools to use as part of a rebrand of hip band 
promoter Quenched Music. It was an open 
brief, but as these things often do, had to 
start with a redesign of the company logo 
using a mix of Illustrator and Photoshop. 
After bringing the logo bang up to date, he 
then moved onto designing a brochure and 
business cards around it, tapping InDesign’s 
newfound ability to include different sized 
pages in a single document. 

I

Award-winning designer Charles Williams explains how using Creative Suite 5.5 can make a rebranding project faster and simpler

1 Start by sketching ideas. At this stage 
I’m looking at the letterforms, how 

they relate to each other, and natural flow. 
I originally developed an idea based on 
origami and folding (above). I spent ages 
designing it, then decided it wasn’t right, 
changed tack, and started afresh – aiming 
for something simpler that has a more 
musical feel (right).

If you don’t already own Creative Suite 5.5, follow along by downloading 
the trial version from adobe.com/uk/designstandard
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The first time you use Photoshop’s 
Content-Aware Fill, I guarantee you’ll  

be wowed by it

2 Once I was happy 
with the rough 

sketch, I drew the type 
in Illustrator onto 
a layer called, naturally, Type. A handy new feature in the latest 
version of Illustrator is the Shape Builder Tool (Shift + M). If you 
want to quickly merge two overlapping shapes, just select them and 
drag the tool across the shapes. 

3 Even when I’m 
completely happy 

with my type, I still like 
to experiment some more 
in case I luck into something new – as I did here by playing around 
with a more geometric look and discovered the hard edges and sharp 
points gave rise to a look that make the viewer immediately think 
of music, as they bring to mind classic rock band logos of the early 
1980s. To avoid losing what I’ve created, I always create a duplicate 
of the Artboard to play around with. The best way to do this is to 
use the Artboard Tool (Shift + O). You can then Alt-drag duplicates 
of the artboard to where you want it.

My final step for the flat logo was to ensure that all the distances 
and thicknesses were consistent. This could then be used across a 
lot of the branding – but I also wanted to create a more textured 
version for use as a piece of type art.

4 Next I wanted to add a bit of depth. I created a layer above 
Type, called Shading. Using the Direct Selection Tool (A), I 

copied an area of the type that I wanted to apply shading to, then 
pasted it in place (Cmd/Ctrl + Shift + V) on the Shading layer. I 
changed its colour to white and set its blending mode to Multiply.  
I locked the other layers to focus on the shading.

5 With the white shape 
selected, I clicked the 

Shape Builder Tool to close the 
shape. Next I clicked on the 
black transparent gradient in 
the Swatches Panel and used 
the Gradient Tool to angle 
the gradient properly. I then 
repeated this process across the 
rest of the type.

To create more depth, I 
repeated Step 4 but applied 
gradient meshes to the corners.

6 Next I moved over to Photoshop, I opened up a paper texture 
image. Overall this was exactly the texture I was looking for, but 

there were a few large blemishes I could do without.
To remove them, I selected them with the Marquee Tool and hit 

Delete. Selecting Content-Aware Fill in the dialog box that appeared 
made the blemishes disappear while filling its space with a seamless 
version of the surrounding texture.

The first time you use Photoshop’s Content-Aware Fill,  
I guarantee you’ll be wowed by it.
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9 Next I placed the texture image file from Step 6 into this 
document. I dragged this texture layer under the type in the 

Layers Panel and created a Layer Mask using a selection taken from 
the type layer. I set the type layer’s blending mode to Multiply, then 
duplicated it. This new layer was given a blending mode of Overlay 
and an Opacity of 50%, so it emphasises the textured look.

It needed to ‘ping’ even more than it does already, so I added an 
Exposure Adjustment layer using the new Adjustments Panel. I put 
a yellow textured background, and the Adjustments Panel allowed 
me to quickly adjust the Exposure setting for the best overall look, 
without having to open and close a dialog repeatedly. Finally  
I cropped the image to A5 landscape ready for use in InDesign.

10 For a flyer, I created a new two-page A5 document in 
InDesign. The first page used the textured logo large, which 

was just brought in at 100% and placed.
On page two, I wanted an irregular grid showing some of the 

artists using Quenched Music. Grids like these are much easier to 
create in InDesign CS5.5 than in CS3. You just go to File > Place 
and select the nine images you want to place, then – while holding 
down Cmd/Ctrl + Shift, draw a grid. Let go of Cmd/Ctrl + Shift and 
use the arrow keys to dictate the number of squares in the grid. 

When drawing out the grid, I allowed a third of the page for type.

11 You can make resizing images in InDesign CS5.5 easier by 
making them automatically fit to the frames they’re in. Just 

select Object > Fitting > Frame Fitting Options and check Auto-fit.
I hit U to access the Gap Tool. This allowed me to click between 

the images and drag them around to create a more interesting 
layout. I also deleted some images to allow more room to extend 
some images. I added a rounded corner to some of the text boxes 
using the new corner control handles accessed by clicking on the 
yellow box on the right edge of every picture frame.

I then added a yellow textured background to match the type art.

12 Next the layout needed some words. I created a text box and 
pasted on a company introduction with a title. I selected the 

copy and created two columns. 
The title needed to span across the columns, so it was time to tap 

the new Span Columns function. From the menu in InDesign’s top 
right corner, select Span Columns and set the Paragraph Layout to 
Span Columns. You can guess what happens. 

Using Creative Suite 5.5 allows me to 
spend less time working out what I want  
to create and more time producing great 
designs that are a hit with clients

7 Back in Illustrator, I 
copied the type shapes 

and pasted them in place 
into a new layer called 
Texture. I then made the 
type white, and set the layer’s 
blending mode to Multiply.

By clicking on the Draw Inside icon and then using File > Place, 
I brought the texture into the document. It automatically placed the 
texture inside the type. This is really exciting, try to remain calm.

I’m doing this in Illustrator just to get a sense of how the texture 
and type work together before moving over to Photoshop for the 
actual compositing.

8 In Photoshop, I created a new 420 x 420mm document. Back 
in Illustrator I selected the Type layer and copied and pasted 

it into Photoshop as a Smart Object. I then repeated this for the 
Shading layer, setting its blending mode in Photoshop to Multiply. 
It’s always handy to keep these on separate layers in case the client 
wants you to change colours or produce different versions. 
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13 I styled the copy using Adobe Garamond Pro, a grey colour 
and a blending mode of Multiply, so that some of the 

underlying texture comes through for an on trend, handmade feel.

14 Our girls and guys need business cards too. In InDesign CS4 
or older, you’d have to create multiple documents to do this – 

but since InDesign CS5, things have been made easier. We can just 
make a new page, at a different size, with ease.

I created a new Master Page, clicked on the small menu at the 
bottom of the Pages Panel and selected Custom Size. I changed it 
to a business card size of 58 x 88mm. I dragged this down to create 
pages three and four as both sides of the card.

15 I then created specific 
artwork for the business 

card by Alt-dragging the logo 
and some of the text from the 
flyer page and resizing – much 
swifter than working with 
multiple documents.

I was done. Using Creative 
Suite 5.5 allowed me to spend 
much less time on working out 
how to achieve what I wanted 
to create and more time on 
producing great designs that 
were a real hit with the client.

Left An 
impressionist 
portrait of cricketer 
Viv Richards for  
GQ magazine

Left Soccer star 
Rio Ferdinand as 
illustrated for  
GQ magazine

Above Striking type produced for Adobe

AUTHOR  CHARLES WILLIAMS 
Charles is an award-winning illustrator and designer based 
in London. His clients include Digital Arts magazine, 
Volkswagen, BBC, Nike, TBWA London, Seat, and Adobe. 
To see his work, visit madeup.org.
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IN-DEPTH ADOBE ACROBAT X PRO

 A SMOOTH WORKFLOW

crobat X Pro – Adobe’s PDF creation, 
communication and collaboration 
tool – has a streamlined interface that 

makes it even more productive and efficient. 
Tools and menu panels only appear when 
users require them in a new mode that’s 
designed for reading and presenting PDFs.  

Acrobat and PDFs are ideal for print 
production tasks; for example, when proofing 
colour-separated documents, Acrobat offers 
an onscreen simulation that approximates 
blending and overprinting. Print designers 
are also well served by an enhanced Output 
Preview featuring an Object Inspector for 
detailing information about assets and 
enhanced colour conversion. 

You can use Acrobat to add printer 
marks temporarily by using the Marks And 
Bleeds panel of the Advanced Print Setup 

• �Preview, preflight, correct, and 
prepare PDF files for high-end 
print production

• �Use PDF Portfolio to unify 
and customise a wide range of 
content into a single document 

• �Send Actions to colleagues and 
print shops to ensure processes 
are followed consistently

• �Use Acrobat.com utilities to 
share and distribute documents 

• �Ensure a design prints the way 
you expect with advanced print 
production tools

5 WAYS ACROBAT X PRO 
WILL MAKE YOU A  
BETTER DESIGNER

A
dialog box, or you can embed printer marks 
in the file using the Add Printer Marks 
dialog. Significant enhancements have also 
been made to the transparency flattener in 
Acrobat X Pro, allowing more accurate work 
with transparent layers during pre-press. 

TAKE OFF 
Acrobat also offers a Preflight tool that 
analyses a PDF and identifies possible 
problems such as issues with colours, 
fonts, transparency, image resolution, ink 
coverage, PDF version compatibility, and 
more. It inspects the file against a set of 
user-defined values – Preflight Profiles – 
using them to correct errors, and run checks 
and fixups on visible areas or certain objects. 

Designers working with print have 
always had to perform sets of tasks like these 
before finalising their work. Adobe intends 
to address this with a new feature in Acrobat 
X Pro called Action Wizard, a way to 
automate repetitive tasks. You can use one 
of seven pre-built Actions, customise one to 
suit your specific file preparation needs, or 
create your own Action with a few steps.  

Say you are preflighting a document and 

adding printer marks so that you can send a 
file to your print bureau. Using the menu-
driven Action Wizard, you can build a script 
that will execute your normal sequence of 
standard preflight steps, packaging it into 
a standardised Action that can be applied 
to single PDF files or batches of files. This 
Action can then be reused or shared with 
anyone in your studio or with outside 
vendors such as print service providers. 
All recipients of the Action have to do is 
double-click it and confirm that they want 
to import it, Acrobat does the rest.  

Another key tool for creatives is the 
PDF Portfolio feature, where multiple 
media types can be assimilated into one 
compressed PDF file. With Acrobat X Pro, 
this too gains a new wizard, able to create 
a portfolio in three steps, digitally sign the 
portfolio and add customised options such 
as new layouts, visual themes, and colour 
palettes to reflect your branding. 

Acrobat also works in conjunction 
with Shared Reviews, the new document 
markup and collaboration services offered 
by Adobe’s Acrobat.com. Your clients don’t 
need the full Acrobat X Pro application 
either – anyone with Adobe Reader can join 
the review process. Final delivery of print 
assets can also cause frustration and high 
costs, but SendNow, another Acrobat.com 
service, enables you to send and receive large 
files directly within 
Acrobat X Pro, as well 
as track them with 
proof of receipt. The 
days of depending 
on overnight delivery 
may just be over. 

Below You can use the 
Compare Documents 
feature to show the 
differences between two 
versions of a PDF, with 
many custom options 
for displaying the 
compare results

To learn more, 
visit adobe.com/uk/

designstandard

Above Reduce errors 
and delays at the printer 
using Preflight checks. 
Run checks and fixes on 
selected objects, and 
view improved reports

Above right Visual 
Themes provide many 
options for changing 
the look and feel of a 
PDF Portfolio without 
having to write custom 
coding or scripts

Right Action Wizard is 
similar to Photoshop’s 
Actions Panel, in that a 
series of tasks are first 
recorded, then played 
back in order  
whenever required 

Creatives can save time and avoid pre-press errors by making the most of Acrobat X Pro’s new features

5 KEY NEW TOOLS IN 
 ADOBE ACROBAT X PRO

•  �Read mode: Streamline your screen for reading and 
presentation of PDFs

•  �Action Wizard: Guide users through multi-step tasks 
and share with others

•  �SendNow: Send and store large documents using 
Acrobat.com services 

•  �Portfolio wizard: Assemble content into PDF Portfolios 
in three easy steps

•  �Centralised Annotations: Streamline markup operations 
and view comments from a single Annotations panel
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WIN
dobe and Digital Arts are giving 
you the chance to get your hands 
on some fantastic Creative Suite 

5.5 products to help you transform your 
creative business – enabling you to deliver 
better design projects quicker to happier 
clients. If your appetite has been whetted 
by the hot new tools and wonderful design 
work produced in this Expert Guide, now 
you can win some or all of these Creative 
Suite tools in our superb competition.

One winner will receive a copy of 
Creative Suite 5.5 Design Standard, worth 
over £1,000, while two runners up will win 
a copy of the design tool of your choice of 
either InDesign CS5.5, Photoshop CS5 or 
Illustrator CS5 – each worth up to £600.

Creative Suite 5.5 Design Standard is 
the must-have toolset for print-focussed 
designers. It enables you to create stunning 
illustrations and graphics in Illustrator CS5, 
swiftly make images look incredible in 
Photoshop CS5, produce beautifully stylish 
layouts in InDesign CS5.5 and take control 
of your output in Acrobat X Pro.

To enter: 
Just answer the question at 
digitalartsonline.co.uk/competitions 
before July 31, 2011
The answer can be found within the pages of this Expert Guide

A

The competition is open to anyone over the age of 18. One entry per household only. No entries accepted from anyone connected with either company. Responsibility will not be accepted for any entries lost or delayed. No cash 
alternative. The winner will be the first correct entry selected after the closing date of July 31, 2011 and will be notified shortly afterwards. The winner’s name will be published in a future issue of Digital Arts. IDG cannot be held 
responsible in the event of a company providing a prize being unable to honour its obligation, for whatever reason. Full terms and conditions can be found at digitalartsonline.co.uk/competitions

TO ENTER, VISIT DIGITALARTSONLINE.CO.UK/COMPETITIONS

Which of these tools isn’t part of Adobe 
Creative Suite 5.5 Design Standard?
A) InDesign CS5.5
B) Photoshop CS5
C) Dreamweaver CS5.5

ADOBE CREATIVE SUITE 5.5 
SOFTWARE WORTH OVER £2,000! 
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In this special guide created by the 
team behind Digital Arts magazine, in 
association with Adobe, discover how 
you can take your design projects to 
the next level using Adobe Creative 
Suite 5.5 Design Standard. You’ll learn 
how the latest versions of InDesign, 
Illustrator, Photoshop and Acrobat Pro 
combine to help you work faster and 
produce your best work ever.

See how the UK’s best independent 
design studios are using Adobe’s tools 

to create fantastic work for clients 
including both household names and 
hip underground brands. We’ve also 
got a step-by-step guide by award-
winning designer Charles Williams as 
he guides you through the techniques 
he used in a recent music-focussed 
rebranding project.

 
You’ll also have the chance to win 
Creative Suite software worth over 
£2,000. Look inside to find out how.
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All other trademarks are the property of their respective owners. 

© 2011 IDG Communications Ltd. All rights reserved.




